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Creating PivotTables 
PivotTables are powerful data analysis tools. They let you summarize data in various ways and 

instantly change the view you use. A PivotTable not only subtotals groups of related data; it also 

compares one group to another. 

Arranging the Source Data 
You create PivotTables from columns or from a table in an Excel worksheet. The data should 

contain no blank rows or columns. Converting a list to a table is recommended when records 

will be added after the PivotTable is created. The additional table data are included 

automatically within the PivotTable when it is refreshed or updated. Data in a list are not 

included automatically. The following examples explain two PivotTables based on the 

worksheet list partially shown here. 

 
The worksheet data 

PivotTable Example 1 
You can sort the preceding table by pledge level or sponsor category, but you cannot easily 

compare totals for the various pledge levels in each sponsor category. A PivotTable can 

summarize some or all data in any number of ways, and it creates grand totals. Each column in a 

PivotTable is a field. Examine the PivotTable and notice that the Sponsor Category field from 

the table is used for the row labels, the Pledge Level field for the column labels, and the Year 2 

field for the data area and grand totals. Each row displays the amount given by each sponsor 

group in the various pledge levels. 
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PivotTable Example 2 
In this example, data is summarized first by pledge level and then by sponsor category. To create 
this type of view, the PivotTable layout shown in the following illustration contains the Pledge 
Level and then Sponsor Category fields for row labels, no column labels, and the Year 2 field for 
the data area and totals. 

 

How PivotTables Work 
Each area of a PivotTable plays a role in data organization. The PivotTable Fields task pane 

displays after you define the worksheet range to be used. The areas of the task pane are 

explained in the following illustration, which displays the settings for PivotTable Example I . 
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Where you place fields within the PivotTable Fields task pane determines how the PivotTable 

summarizes the data. By choosing different fields or dragging and dropping a field, you can 

quickly compare data in various ways. You may choose from several functions—such as SUM, 

COUNT, and AVERAGE—to calculate fields containing values. 

Create PivotTables 
 

1. Open Sponsors from the EX2013 Lesson 01 folder and save it as Sponsors- 

[FirstlnitialLastName]. 

2. Select cell B4 and choose Insert—Tables, PivotTable. 

3. Verify that the table/range agrees with the one displayed here, and then click OK. 

 

4. Rename Sheet I to PivotTable by Sponsor Category, and then select cell Al 

5. Select cell A3 to restore the task pane. 

6. Follow these steps to define the PivotTable in the task pane: 
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7. Choose PivotTable Tools—Analyze, PivotTable, Options. 

8. Type BySponsorCategory in the PivotTable name text box and tap [Enter]. 

9. Display the Sponsors Table worksheet. 

10. With any table cell selected, choose Insert, Tables, PivotTable, verify that the suggested 

range is the Sponsors_Table, and click OK. 

11. Rename the new sheet PivotTable by Pledge Level. In the PivotTable Fields task pane, 

place a checkmark next to field names in this order: Pledge Level, Sponsor, Category, 

Year 2. 

 

12. Choose PivotTable Tools—Analyze, PivotTable, Options. 

13. Type ByPledgeLevel in the PivotTable name text box and tap [Enter]. 

14. Save the file and leave it open; you will modify it throughout this lesson. 
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Formatting a PivotTable 
Values and subtotals in a PivotTable do not automatically display the formatting from the 

original worksheet cells. You may select and format one or more specific cells in the PivotTable 

using standard Ribbon commands. Alternatively, the PivotTable Tools Design contextual tab 

contains a large selection of PivotTable styles that can be used to quickly apply color, shading, 

and gridlines. The report layout displays in Compact Form by default, but you may choose from 

two other layouts. The subtotals may be displayed at the top or bottom of each group, or can be 

hidden. 

 

Format a PivotTable 
 

1. Save your file as Sponsors- [FirstinitialLastName]. 

2. Display the PivotTable by Sponsor Category worksheet, select the range B4:H4, 

and right-align the labels. 

3. Choose PivotTable Tools—Design, Layout, Grand Totals. Experiment by 

choosing each option and observing its result, and then choose On for Rows and 

Columns. 

4. Select any cell in the PivotTable. 

5. Follow these steps to format the Year 2 contribution numbers:  
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6. Display the PivotTable by Pledge Level worksheet. 

7. Click in the PivotTable, choose PivotTable Tools—Design, PivotTable Styles, 

More, and choose Pivot Style Medium 9. 

8. Choose PivotTable Tools—Design, Layout, Report Layout—Show in Outline 

Form. 

9. Choose PivotTable Tools—Design, Layout, Report Layout—Show in Tabular 

Form. 

10. Choose PivotTable Tools—Design, Layout, Report Layout—Show in Compact 

Form to return to the original layout. 

11. Save the file and leave it open. 

Changing PivotTable Fields 
You may add or remove fields on a PivotTable simply by adding or removing the checkmark 

next to the field name in the PivotTable Fields task pane. The PivotTable will automatically 

reconfigure to display the new data. You may also change the order of fields within the row and 

column areas. One of the most powerful ways of manipulating data is to move a field from the 

row area to the column area or vice versa. This is called pivoting the field (hence the name 

PivotTable). The display of the data field rotates to give you an entirely different view of your 

data, as illustrated in the two PivotTables you created in the previous exercise. There, you 

positioned the Pledge Level field to display as columns in the first PivotTable and as rows in the 

second. 
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Change PivotTable Fields 
 

1. Save your file as Sponsors- [FirstinitialLastName]. 

2. Display the PivotTable by Pledge Level worksheet. 
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3. Place a checkmark next to Year 1 in the task pane to add this field to the 

PivotTable. 

4. Right-click any cell in the Sum of Year 1 column of the PivotTable and choose 

Number Format. 

5. In the Format Cells dialog box, choose the Number category, set 0 decimal places, 

check the Use 1000 Separator ( , ) option, and click OK. 

6. Repeat steps 4—5 to format the Sum of Year 2 column. 

7. Drag Sum of Year 2 below Sum of Year 1 in the Values area. 

 

 

8. Place a checkmark by the Sponsor Name field in the top section of the PivotTable Fields 

task pane. 

 

 

9. Remove the checkmark by the Sponsor Category and Sponsor Name fields in the 

PivotTable Fields task pane; add a checkmark next to Team Leader. 

10. Drag the Team Leader field from the Rows area to the Columns area below the 

Values field. 
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11. Undo  the pivot. 

12. Save the file and leave it open. 

Filtering a PivotTable with AutoFilter 
You may set the PivotTable to filter, or include, specific items in the data summaries. The totals 
and subtotals are recalculated for the selected items. The Row Labels and Column Labels 
headings have an AutoFilter button that displays the same sorting and filtering options that are 
available on the columns of worksheet lists and tables. 
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Filtering PivotTables with Slicers 
Slicers are menu frames displayed on worksheets that contain all filtering choices in one field. 

Selected items are highlighted in slicers, making it easy to identify currently applied criteria. 

Slicer frames may be resized, moved, and formatted with styles for a consistent appearance. 

Slicers may also be shared in other worksheets of the same workbook for use with multiple 
PivotTables based on the same data set. Changing the filtering selections in a shared slicer 
causes all connected PivotTables to update automatically. 

 

Filter a PivotTable with Slicers 
 

1. Save your file as Sponsors- [FirstinitialLastName]. 

2. Display the PivotTable with Slicers worksheet. 

3. Select any cell in the PivotTable and choose PivotTable Tools—Analyze, Filter, 

Insert Slicer. 

4. Place a checkmark next to Pledge Level, Team Leader, and Sponsor Category; 

click OK. 

5. Select cell A1 to hide the PivotTable Fields task pane, if still displayed. 

6. Follow these steps to move and resize the Sponsor Category slicer: 
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7. Drag the Pledge Level and Team Leader slicers to row 19. 

 

8. Click the Pledge Level title to display the slicer's frame, and then hold down  
[Shift]  and click the Team Leader title. 

9. Choose Slicer Tools—Options, Buttons, Columns and change the number of 

columns to 2. 

10. Click the Sponsor Category title in the slicer at the right of the PivotTable, choose 

Slicer Tools—Options, Slicer Styles, More, and choose any style. 

11. Apply the styles of your choice to the Pledge Level and Team Leader slicers. 

12. Choose Level 2 in the Pledge Level slicer. 

 
13. Click the Clear Filter button on the Pledge Level slicer. 
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14. Select Corporate Sponsorship in the Sponsor Category slicer, hold down [Ctrl], 

and select Individual Sponsorship. 

15. Save the file and leave it open. 

Editing PivotTable Calculations 
You are not limited to summing values in a PivotTable, and you may create formulas within 
PivotTables when necessary. 

Changing the Function for a Values Area Item 

By default, the subtotals and grand totals in a PivotTable sum the values in a field. You may 
change the SUM function to a different function, such as AVERAGE, MAX, or COUNT 

If the Values area of the PivotTable Fields task pane contains only one entry, all SUM columns 
will change to the function you selected. If multiple entries exist in the Values area, you may 
change the function for one entry at a time. 

Creating a Calculated Field 

Some functions are not available on the Summarize Values By tab of the Value Field Settings 
dialog box. These functions may be typed in the Insert Calculated Field dialog box. A calculated 
field contains a formula using values from one or more existing fields. For example, the formula 
could subtract the value in one field from another to find the difference. 

 

Converting Column Data to a Calculation 

The Show Values As tab of the Value Field Settings dialog box can be used to create formulas 
employing preset options. For example, you can calculate percentages of a total, the difference 
between values in two columns, a running total, or a ranked order. If you want to display the 
original column data along with the converted data, simply drag and drop the field name from 
the field list to the Values area to create a duplicate field. 

Refreshing PivotTable Data 

PivotTables are often created with data from sources external to the Excel workbook 
containing the PivotTables. After you change the source data— even if in a worksheet range 
or table within the same workbook—you must refresh the PivotTables manually. You may 
refresh just the active PivotTable or all PivotTables in the workbook. You may also set a 
PivotTable option to refresh data from external sources when the workbook is opened. 
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Change PivotTable Calculations 
 

1. Save your file as Sponsors- [FirstinitialLastName]. 

2. Display the PivotTable by Pledge Level worksheet. 

3. Select a number cell in column B of the PivotTable, and then choose PivotTable 
Tools, Analyze, Active Field—Field Settings. 

4. Select Average on the Summarize Values By tab and click OK. 

5. Choose PivotTable Tools, Analyze, Calculations, Fields, Items, & Sets— Calculated 

Field. 

6. Follow these steps to create a calculated field: 

 

 

7. Display the Sponsors Table worksheet. 

8. In cell F98 change 250,000 to 200000, and then display the PivotTable by Pledge 

Level worksheet. 

9. Choose PivotTable Tools, Analyze, Data, Refresh menu, Refresh All. 

10. Save the file and leave it open. 
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Creating PivotCharts 
A PivotChart presents data from a PivotTable. There are two ways to create a 
PivotChart. 

1. Chart an existing PivotTable by choosing a chart type from the Insert tab, as you 
would do for a normal Excel chart. 

2. Use the PivotChart command to create a PivotTable and PivotChart from the source 
data at the same time. The chart builds as you choose fields in the PivotTable Fields 
task pane. 

 
The fields in the values area of the PivotTable are displayed as data series in the chart. 
The row labels in the PivotTable are used as the axis labels in the chart; the column 
labels are the data series in the chart legend. 

Filtering PivotCharts  
 

The PivotChart may be filtered using the AutoFilter buttons on the chart, AutoFilter buttons on 
the PivotTable, or slicers added to the worksheet. The filtering is applied to the related 
PivotTable as well. 

 

 

Formatting and Printing PivotCharts 
You format PivotCharts using the same Ribbon commands as you do for normal Excel charts. 
Some chart formatting, such as data labels, is not preserved after a PivotChart is refreshed. 

Create a PivotChart 

 

 

1. Save your file as Sponsors- (FirstinitialLastName]  

The chart 

columns depict 

the PivotTable 

column values. 

The data may 

be filtered using 

the AutoFilter 

buttons. 



16 
 

2. Display the PivotChart worksheet. 

3. Select any cell within the PivotTable, and then choose Insert, Charts, Insert 

Column Chart, 2-D Column, Clustered Column. 

4. Point at the chart frame and drag the chart just below the PivotTable. 

5. Place a checkmark next to Year 2 in the PivotChart Fields list. 

6. To filter the PivotChart, choose the Pledge Level AutoFilter button at the lower-

left corner of the PivotChart, remove the checkmark next to Level 4, and click OK. 

7. Select the chart, choose PivotChart Tools, Design, Type, Change Chart Type, 

Column, 3-D Clustered Column, and click OK. 

8. Save and close the file. 

 

Quick items for PivotTables 
Using the Quick Analyzes feature 

1. Open the PivotTablesWithCtrl+q Excel file. 

2. With the 3 years of sales sheet selected, press Ctrl + q. 

3. Click the Tables menu at the top. 

( You will see 4 PivotTables with question marks listed) 

4. Move the mouse over each one to see the Pivot table you can build. 

5. Click the Sum of Sales by City, the first one with the question mark. 

 

To sort by sales and have that city at the top 

6. Right click in the cities list. 

7. Point to Sort on menu, click More Sort Options… menu. 

 

8. In the Sort (City) dialog box, select the Descending option. 
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9. Click the down arrow and select Sum of Sales. 

 

This will list cities with the most sales first going down the PivotTable. 

10.  Click the OK button. 

Using another quick feature for percent 

 

1. Drag Sales into Values box for a second Sales field. 

But what we really want here is the percent of sales for each city. 

2. Click the down arrow for the “Sum of Sales2”. 

3. Click Value Field Settings… menu. 

 

4.  Click the tab Show Values as. 

5. Click the down arrow for Show values as list.  

 

6. Select the % of Grand Total from the drop-down list. 
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7. Click OK button to apply the % for Sales. 

8. Click in cell C3 and type: Percent of Sales  

9. Press [Enter] to complete your new heading. 
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Create a Relationship a cross sheets to build a Pivot Table 
In Excel 2013 and 2016/365 you can now create a relationship between tables of data. This is 
a feature that can be used to pull data from the different tables to build a PivotTable. 

The first step in this process is to format the data/table with the Format as Table feature. 
This can be found on the Home tab, as part of the Styles group. 
 

 

Once you have formatted the table you need to give it a name. Naming the tables will make it 
easier to identify and work with your data in the Pivot Table. Third, you will need to setup a 
relationship between each of the three tables. 

In the following scenario, using hotel data (you as the employee), have downloaded new data  into Excel from 

the hotel’s SQL database. You have downloaded three tables that you would like to use in a pivot table. 

These three tables are; Customers, Reservations and Rooms tables. 

As mentioned above, to be able to build a pivot table from all three tables you will need to prepare the data 

first. The first step is to format each table as a table using the Format as Table feature. Second name each 

table with a unique name. Third, setup a relationship with each table using the Relationship feature on the 

Data ribbon. 

After the above three steps are done, you will need to use of Excel’s Business Intelligent the PowerPivot 

add-in. If it is not currently one of your tabs in Excel, you will need to active this add-in.  

(Click File, Options, Add-ins category. At the bottom 

of the dialog box click the down arrow for Manage 

and select COM Add-ins and click the Go button.  

In the Add-ins available list check the box for Microsoft Power Pivot for Excel. Then click OK.)

 
Using the Power Pivot ribbon you add each table to your Data Model. After all are added, click Manage, Click 

Pivot Table on the Home ribbon. 

Building a pivot table using multiple tables 
 

1. Click in the Customers table  

2. On the Home ribbon, click the Format as Table button and select Blue, Table 

Style Medium 6. 
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The style is in the Medium section first row. 

3. In the Format As Table dialog box, confirm that “My table has headers” is 

checked. 

 

4. Click the OK button. 

5. On the Design ribbon click in the Table Name box, type: 

Customers and press [Enter]  

You have created your first formatted table and named the table. 

1. Repeat steps 1 – 5 for the other two tables. 

2. Name the tables the same as the sheet names; Reservations and Rooms. 

In the next few steps you will create the relationship between the three tables. If you look at each table you 

will notice that the Customers table has a CustID column and the Reservations table has a CustID column. 

This unique identifier will be used to create the first relationship. The second will be between the 

Reservations table which has a RoomID column and the Rooms table which has a RoomID column. 

1. With the Customers worksheet selected, click the Data tab, in the Data Tools group click 

Relationships button. 

 
2. In the Manage Relationships dialog, click the New button. 

 

Your screen should look like this. 

 

3. Click the Table down arrow and select Worksheet Table: Customers from the list. 

4. Click the Column (Foreign) down arrow and select CustID from the list. 

5. Click the Related Table down arrow and select Worksheet Table: Reservations from the list. 

6. Click the Related Column (Primary) down arrow and select CustID from the list. 
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Your screen should look like this. 

 
 

7. Click the OK button to complete the first relationship. 

Next you will create the second relationship. 

1. Click the New… button in the Manage Relationships dialog. 

2. Click the Table down arrow and select Data Model Table: Reservations from the list.  

3. Click the Column (Foreign) down arrow and select RoomID from the list.  

4. Click the Related Table down arrow and select Worksheet Table: Rooms from the list. 

5. Click the Related Column (Primary) down arrow and select RoomID from the list. 
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Your screen should look like this. 

 
 

6. Click the OK button to complete the second relationship. 

7. Click the Close button to exit the Manage Relationships dialog. 

Now you are ready to view your Data Model in the Power Pivot Data Model Manager. On the Home ribbon 

of Power Pivot Manage feature you can create a Pivot Table. 

1. Click the Power Pivot tab and click the Manage button in the Data Model group. 

Your screen should look like this. 

 

2. Click each of the sheet tabs at the bottom of the Manage window to view the data. 

3. On the Home tab of the Power Pivot Manage ribbon, click the top half of the PivotTable button. 

4. When the Create PivotTable dialog appears, click the OK button to place on a new worksheet. 

 

A new sheet is added to your workbook and the PivotTable structure appears. However; this PivotTable is a 

little different from ones you may have created before. In the PivotTable Fields pane you notice there are 

three items listed; Customers, Reservations and Rooms. But these are not fields these are the header for a 

field list. 
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Your screen should look like this. 

 

1. Click the arrow head next to Customers to expand and drag CustName down to Rows box. 

2. Click the arrow head next to Reservations to expand and drag ResValue down to Values box. 

3. Click the arrow head next to Rooms to expand and drag RoomType down to Columns box. 

Your screen should look like this. 

 

You have created a PivotTable from 3 different sheets of data, using a relationship to connect all three 

together which creates a Data Model. 

What is DAX 

DAX stands for Data Analyze Expression and is used in Excel to write formulas using words rather than 

cell addresses. Primarily it is used when working in PowerPivot but can be used with a formatted table. 


